**Comment Form**  
**RS3™ Manuals**

**ABC Batch Operator’s Guide**

Please give us your feedback to help improve this manual.

1. Do you actually use this manual when you are:  
   - configuring
   - making changes or enhancements
   - operating the system
   - troubleshooting
   - other __________________________  

<table>
<thead>
<tr>
<th>Never</th>
<th>Rarely</th>
<th>Sometimes</th>
<th>Usually</th>
<th>Always</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

2. Does this manual answer your questions?  

<table>
<thead>
<tr>
<th>Never</th>
<th>Rarely</th>
<th>Sometimes</th>
<th>Usually</th>
<th>Always</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

3. What could be changed in this manual to make it more useful?

Errors and Problems: Please note errors or problems in this manual, including chapter and page number(s) of affected information, if applicable; or send a marked-up copy of the affected page(s).

May we contact you about your comments?  

- [ ] Yes  
- [ ] No

**Name** ______________________________________________  
**Company** ______________________________________________  
**Phone** ______________________________________________  
**Date** ______________________________________________  

Thank you!

Fisher-Rosemount FAX #: (612) 895-2044
About This Manual

This manual is an operator’s guide to using the RS3™ ABC Batch Software System. It explains how to operate and run ABC Batch recipes.

Section 1 Describes the features of ABC Batch recipes.

Section 2 Describes how to set up and run recipes.

Section 3 Describes ABC Batch process graphics that operators use.

Changes for This Release

- Information on ABC Batch Messaging has been added.
- Corrections and minor revisions have been made.
# Revision Level for This Manual

<table>
<thead>
<tr>
<th>For This Software Version:</th>
<th>Refer to This Document:</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Title</td>
<td>Date</td>
</tr>
<tr>
<td></td>
<td>ABC Batch Operator’s Guide</td>
<td>June 1999</td>
</tr>
<tr>
<td>P1R3.3</td>
<td>ABC Batch Operator’s Guide</td>
<td>May 1996</td>
</tr>
<tr>
<td>P1</td>
<td>ABC Batch Operator’s Guide</td>
<td>August 1994</td>
</tr>
<tr>
<td>18R2</td>
<td>ABC Batch Operator’s Guide</td>
<td>October 1993</td>
</tr>
<tr>
<td>18R1</td>
<td>ABC Batch Operator’s Guide</td>
<td>August 1992</td>
</tr>
<tr>
<td>17</td>
<td>ABC Batch Operator’s Guide</td>
<td>January 1992</td>
</tr>
</tbody>
</table>
References to Other Manuals

References to other RS3 user manuals list the manual, chapter, and sometimes the section, as shown below.

**Sample Entries:**
For ..., see CC: 3. For ..., see CC: 1-1.

<table>
<thead>
<tr>
<th>Manual Title</th>
<th>Chapter</th>
<th>Manual Title</th>
<th>Chapter-Section</th>
</tr>
</thead>
</table>

**Abbreviations of Manual Titles**
- **AL** = Alarm Messages
- **BA** = ABC Batch
- **CB** = Control Block Configuration
- **CC** = Console Configuration
- **DT** = Disk and Tape Functions
- **IO** = I/O Block Configuration
- **OP** = Operator’s Guide
- **OV** = System Overview and Glossary
- **PW** = PeerWay Interfaces
- **RB** = Rosemount Basic Language
- **RI** = RNI Installation Guide
- **RR** = RNI Release Notes
- **RP** = RNI Programmer’s Reference Manual
- **SP** = Site Preparation and Installation
- **SV** = Service
Reference Documents

Prerequisite Documents

You should be familiar with the information in the following documents before using this manual:

- *System Overview Manual and Glossary* 1984-2640-21x0
- *Software Release Notes, Performance Series 1* 10P56870108

Related Documents

You may find the following documents helpful when using this manual:

- *ABC Batch Software Manual* 1984-2654-21x1
- *Alarm Messages Manual* 1984-2657-19x1
- *ABC Batch Quick Reference Guide* 1984-2818-1104
- *Console Configuration Manual* 1984-2643-21x0
- *ControlBlock Configuration Manual* 1984-2646-21x0
- *I/O Block Configuration Manual* 1984-2645-21x0
- *PeerWay Interfaces Manual* 1984-2650-21x0
- *RNI Programmer’s Reference Manual* 1984-3356-03x1
- *RNI Installation Guide* 1984-3357-0301
- *RNI Release Notes* 10P57483001
- *Rosemount Basic Language Manual* 1984-2653-21x1
- *Service Manual, Volume 1* 10P569802x1
- *Service Manual, Volume 2* 10P569802x2
- *Site Preparation and Installation Manual* 10P569902x1
- *User Manual Master Index* 1984-2641-21x0
## Contents

### Section 1: ABC Batch Overview ................................................. 1-1
- Batch Recipes ................................................................. 1-2
- Batch Unit Sets ............................................................... 1-3
- Formulas ............................................................................. 1-4
- Recipe Components ............................................................ 1-5
- Menu Bar ............................................................................. 1-5
- Menu Fields ......................................................................... 1-6
- Subrecipe Types for Parallel Batch Units ............................... 1-7
- Icons ................................................................................... 1-8
- Links ................................................................................... 1-10
- Paths and Branches ............................................................. 1-11
- Icon Numbers ..................................................................... 1-11
- Decision Labels ................................................................. 1-12
- Virtual Memory Files .......................................................... 1-13

### Section 2: Running ABC Batch Recipes ................................. 2-1
- Starting the Control Recipe .................................................. 2-2
- Calling Up the Control Recipe .............................................. 2-2
- Entering Parameter Values .................................................. 2-4
- Calling Up the Parameters Menu ........................................... 2-5
- Selecting Formulas ............................................................. 2-6
- Editing Parameters ............................................................. 2-6
- Assigning a Batch ID to the Control Recipe ......................... 2-7
- Validating and Starting the Control Recipe ......................... 2-10
- Selecting Batch Unit Sets .................................................... 2-10
- Beginning Validation .......................................................... 2-11
- Responding to Validation Warnings and Errors .................... 2-12
- Parameters Without Values ............................................... 2-13
- Starting the Control Recipe from the Error Log Menu .......... 2-14
- Printing Recipes ................................................................. 2-16
- Defining Recipe Locals ....................................................... 2-17
- Useful Commands ............................................................... 2-18
- Scrolling the Working Recipe .............................................. 2-18
- Calling Up a Process Graphic from the Working Recipe ......... 2-18
- Calling Up an Operator Comment Screen ............................ 2-19
- Blocking and Unblocking Recipe Icons ............................... 2-19
- Suspending and Restarting Recipe Execution ....................... 2-21
- Locking and Unlocking Unit Recipes ................................... 2-23
- Creating a Window Label .................................................... 2-24
- Tracing Links ..................................................................... 2-25
AO: x

Changing Icon Size .................................................. 2-27
Calling Up the Master Recipe ........................................ 2-28

Section 3: Using Batch Process Graphics ....................... 3-1

  Batch Input Window: BAINPUTW Object ..................... 3-2
  Recipe Viewing Window: BARCPW Object ................... 3-3
  Batch Faceplate: BFACE Object ............................... 3-4
  Recipe Faceplate: RECIPE Object ............................. 3-5
# List of Figures

<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.1</td>
<td>ABC Batch Recipe Management System</td>
<td>1-2</td>
</tr>
<tr>
<td>1.2</td>
<td>Using Batch Units</td>
<td>1-3</td>
</tr>
<tr>
<td>1.3</td>
<td>Using Formulas</td>
<td>1-4</td>
</tr>
<tr>
<td>1.4</td>
<td>Main Recipe and Parallel Unit Recipe</td>
<td>1-6</td>
</tr>
<tr>
<td>1.5</td>
<td>Icons on a Batch Control Recipe</td>
<td>1-8</td>
</tr>
<tr>
<td>1.6</td>
<td>Icons on a Main Recipes and Unit Recipe</td>
<td>1-9</td>
</tr>
<tr>
<td>1.7</td>
<td>Alternate and Parallel Operations</td>
<td>1-10</td>
</tr>
<tr>
<td>1.8</td>
<td>Icon Numbers</td>
<td>1-11</td>
</tr>
<tr>
<td>1.9</td>
<td>Decision Labels</td>
<td>1-12</td>
</tr>
<tr>
<td>1.10</td>
<td>Identifying a Virtual Memory File</td>
<td>1-13</td>
</tr>
<tr>
<td>2.1</td>
<td>Batch Control Recipe</td>
<td>2-3</td>
</tr>
<tr>
<td>2.2</td>
<td>Calling Up the Parameters Menu</td>
<td>2-5</td>
</tr>
<tr>
<td>2.3</td>
<td>Editing Parameters</td>
<td>2-7</td>
</tr>
<tr>
<td>2.4</td>
<td>Calling Up the Validation/Start Menu</td>
<td>2-8</td>
</tr>
<tr>
<td>2.5</td>
<td>Entering the Batch ID</td>
<td>2-9</td>
</tr>
<tr>
<td>2.6</td>
<td>Calling Up the Validation/Start Menu</td>
<td>2-10</td>
</tr>
<tr>
<td>2.7</td>
<td>Validating and Starting the Control Recipe</td>
<td>2-11</td>
</tr>
<tr>
<td>2.8</td>
<td>Responding to Validation Warnings and Errors with Error Log Menu</td>
<td>2-12</td>
</tr>
<tr>
<td>2.9</td>
<td>Warnings Displayed in the Error Log Menu</td>
<td>2-15</td>
</tr>
<tr>
<td>2.10</td>
<td>Starting the Control Recipe from the Error Log Menu</td>
<td>2-15</td>
</tr>
<tr>
<td>2.11</td>
<td>Calling Up the Print Menu</td>
<td>2-16</td>
</tr>
<tr>
<td>2.12</td>
<td>Printing the Control Recipe</td>
<td>2-16</td>
</tr>
<tr>
<td>2.13</td>
<td>Defining Recipe Locals</td>
<td>2-17</td>
</tr>
<tr>
<td>2.14</td>
<td>Scrolling the Working Recipe with the “Follow” Field</td>
<td>2-18</td>
</tr>
<tr>
<td>2.15</td>
<td>Calling Up a Process Graphic with the “Graphic” Field</td>
<td>2-18</td>
</tr>
<tr>
<td>2.16</td>
<td>Calling Up an Operator Comment Screen</td>
<td>2-19</td>
</tr>
<tr>
<td>2.17</td>
<td>Blocking and Unblocking a Recipe</td>
<td>2-20</td>
</tr>
<tr>
<td>2.18</td>
<td>Suspending and Restarting a Recipe</td>
<td>2-22</td>
</tr>
<tr>
<td>2.19</td>
<td>Locking a Unit Recipe</td>
<td>2-23</td>
</tr>
<tr>
<td>2.20</td>
<td>Unlocking a Unit Recipe</td>
<td>2-23</td>
</tr>
<tr>
<td>2.21</td>
<td>Creating a Window Label Field</td>
<td>2-24</td>
</tr>
<tr>
<td>2.22</td>
<td>Calling Up the Edit Menu</td>
<td>2-25</td>
</tr>
<tr>
<td>Section</td>
<td>Title</td>
<td>Page</td>
</tr>
<tr>
<td>-----------</td>
<td>---------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>2.23</td>
<td>Turning On the Previous, Both, or Next Links</td>
<td>2-26</td>
</tr>
<tr>
<td>2.24</td>
<td>Changing Icon Size</td>
<td>2-27</td>
</tr>
<tr>
<td>2.25</td>
<td>Batch Master Recipe</td>
<td>2-28</td>
</tr>
<tr>
<td>3.1</td>
<td>BAINPUTW Graphic Object</td>
<td>3-2</td>
</tr>
<tr>
<td>3.2</td>
<td>BARCPW Graphic Object</td>
<td>3-3</td>
</tr>
<tr>
<td>3.3</td>
<td>BFACE Graphic Object</td>
<td>3-4</td>
</tr>
<tr>
<td>3.4</td>
<td>RECIPE Object</td>
<td>3-5</td>
</tr>
</tbody>
</table>
Section 1:
ABC Batch Overview

Operators are responsible for starting ABC Batch recipes and monitoring their execution. This section describes recipe design features that operators need to understand in order to perform recipe procedures. It also describes operator responsibilities. For more information on features and functions described in this manual, see the *ABC Batch Software Manual* (BA).

Operators are granted system access (user privileges) by:

1. An operator console key or a password—Either a key inserted into the console or a password identifies the operator’s job category to the system. The system in turn grants the operator certain user privileges based on that job category. All fields in which the operator can enter data are indicated by a greater than (>) symbol. For example:

   Batch Id > B2-6391

2. Through privileges assigned by the system administrator—The system administrator can configure several different combinations of operator privileges, from restricted use to nearly full system access.

Regardless of how the system administrator configures the system, the operator key allows a basic set of privileges. This section covers only the functions associated with that basic set of operator privileges. If you are allowed more extensive system privileges, you should refer to *ABC Batch Software Manual* for a more detailed description of all ABC Batch features.
Batch Recipes

In ABC Batch processing, each batch product is produced by a recipe. ABC Batch recipes use icons and flow charts to represent graphically the actual production steps and equipment in the batch process. ABC Batch has three types of recipes:

- **Master Recipe**: The recipe flow chart is configured on the Master Recipe. A chemist typically designs a Master Recipe by creating operation icons and arranging them in the proper order on the flow chart.

- **Control Recipe**: The Control Recipe is used to assign plant equipment (batch units) and parameters to the recipe and start the batch process.

- **Working Recipe**: A Working Recipe is automatically created when you start the Control Recipe. You use the Working Recipe to monitor and control the execution of the process.

These recipes can also contain subrecipes called the Main Recipe and Unit Recipes. They are described under “Recipe Components” starting on page 1-5.

Figure 1.1 shows the ABC Batch recipe management system.
Batch Unit Sets

A batch unit is a piece of equipment or a group of equipment that functions as a unit. A batch unit set is an ordered group of batch units that defines the sequence of batch units used by the batch recipe. Batch unit sets are used by the recipe to make a specific batch product and provide a flexible manufacturing environment for multiproduct batch manufacturing. You can use batch unit sets to utilize different batch hardware with the same recipe. By using different batch unit sets, the recipe can execute different units with the same operations.

In Figure 1.2, notice how each unit set defines one possible sequence of equipment called batch units. The unit set you assign to the recipe determines the equipment used to make the batch product.

![Figure 1.2. Using Batch Units](image)
Formulas

You can use formulas to make different grades of product with the same recipe. A formula is a set of parameter values assigned to the recipe. Each formula can contain all the values necessary to make a particular grade of product. By changing formulas, you can assign unique values to parameters for each product grade produced by the recipe.

Figure 1.3 shows how formulas are used.

Figure 1.3. Using Formulas
Recipe Components

Batch recipes have the following components:

- Menu bar
- Menu fields
- Icons
- Subrecipes
- Links
- Paths and branches
- Icon numbers
- Decision labels

The following pages describe each of these components.

Menu Bar

Figure 1.4 shows the Batch Master Recipe and Menu Bar. The menu bar calls up the following menus:

- Information
- Save
- Parameters
- Validate
- Edit
- Print
- Locals

These menus are used to configure, maintain, and run the recipe. Choosing one of these menus causes a menu box to open with fields in which to enter information, select options, and so forth. Once you have entered the appropriate information, you confirm the entries by pressing [SELECT] on the “Accept” field. You can cancel the entries by moving the cursor on the “Close” field.
Menu Fields

Menus can have four different types of operator fields. The default color indicates the field type:

- **Command**: Yellow colored fields execute commands. You must press [SELECT] on the field to execute the indicated command.
- **Callup**: Cyan colored fields automatically call up or close a menu when you position the cursor on the field.
- **Input**: Green colored fields introduced by a “>” symbol are used to enter data values.
- **Action**: Magenta colored fields indicate that an action or value is required.
Subrecipe Types for Parallel Batch Units

Parallel batch units require two different types of subrecipes, the Main Recipe and Unit Recipes. Subrecipes coordinate parallel processing in two or more batch units with the same Working Recipe.

**Main Recipe**
Defines all the units used in the batch process and starts execution of the Unit Recipes.

**Unit Recipe**
Performs operations on a batch unit specified in the Main Recipe. Each unit recipe runs in a Coordinator Processor (CP) task specified in the Batch Units Table for the batch unit.

The Unit Recipe can perform all operations on a specified batch unit. The Main Recipe only needs to start the Unit Recipes by executing a Start-UR icon. The order of Start-UR icons in the Main Recipe determines the order of execution of Unit Recipes. For example, in Figure 1.4, the Start-UR icons that start the Unit Recipes are configured in parallel in order to process in parallel batch units.

A recipe can have up to 19 Unit Recipes. Icon numbers for Unit Recipes start at 101, 201, 301, and so forth for each Unit Recipe. A Unit Recipe can have up to 100 icons. For more information on icons used by the Main Recipe and Unit Recipes, see the icon types shown on the following pages.

**NOTE:**
- The term Main Recipe is only relevant when Unit Recipes are used. The Main Recipe defines all the units in the batch process and starts execution of the Unit Recipes.
- Because the Main Recipe coordinates Unit Recipes, it can have only one Unit-Process icon. To facilitate communications, the Main Recipe should not change process units.
- The 19 Unit Recipe limit exceeds the 16 batch unit limit for batch unit sets. If you use more than 16 Unit Recipes, you cannot use a single batch unit set to make unique batch unit assignments.
Icons

Icons are shapes on a recipe flow chart that represent operations, batch units, materials, and decisions. When icons are linked together on the flow chart, they form paths and branches. When run, the recipe executes operations in the order indicated by the icon paths and branches.

Figure 1.5 shows a recipe with six types of icons available in ABC Batch.

![Figure 1.5. Icons on a Batch Control Recipe](image)

- **Label icon**: Designates a starting point within the recipe. Labels can be used with Goto icons to form execution loops.
- **O-Icon (Operations)**: Designates batch operations in the batch process.
- **Decision icon**: Selects one of two or more paths in response to a condition.
- **M-Icon (Materials)**: Combines a material and an operation.
- **Unit-Process icon**: Assigns or changes equipment (called batch units) used by the recipe.
- **Goto icon**: Directs execution to a Label icon to form an execution loop.
Figure 1.6 shows icons used to process parallel batch units. These icons are organized as subrecipes called the Main Recipe and Unit Recipes.

**Start-UR:** Starts execution of a Unit Recipe.

**Unit-Recipe:** Identifies the start of a Unit Recipe. The Unit-Recipe name and unit must match the name of the Start-UR icon.

**Comm-Op:** Send and receive values and coordinate execution between subrecipes. Comm-op icons are used in pairs.

Figure 1.6. Icons on a Main Recipes and Unit Recipe
Links

A link is a line that connects two icons. Links appear as either single or double lines:

- Single line links indicate the sequential order of icons or alternate branches after a Decision icon.
- Double line links connect O-Icons for parallel operations. Parallel operations let the recipe execute two or more operations at the same time.

Decision icons let a recipe choose between two or more alternate links. Figure 1.7 shows an example of links introduced by a Decision icon and an example of a link with parallel operations.

**Figure 1.7. Alternate and Parallel Operations**
Paths and Branches

When icons are linked together, they form paths and branches.

- **Path** refers to the sequence in which icons are executed. A path begins at the default Unit-Process icon or with a Label icon and ends at the default END icon or a Goto icon.

- **Branch** refers to one of several alternate or parallel sequences of icons in a recipe.

Icon Numbers

Each icon has a number on the upper left corner. Icons are numbered in the order in which they are created. If you have configuror privileges, you can change numbers to a sequential order on the flow chart. If an icon is deleted, the recipe flow chart renumbers the remaining icons. Figure 1.8 shows examples of icon numbers.

![Diagram of Icon Numbers](image)

Figure 1.8. Icon Numbers
Decision Labels

Decision labels identify alternate links after a decision icon. Labels are optional and must be defined by the configuror. Figure 1.9 shows an example of labels configured for a decision icon.

In the default state, decision links are assigned numbers instead of labels.

![Figure 1.9. Decision Labels](image-url)
Virtual Memory Files

A tilde ( ~ ) symbol preceding the recipe name indicates that the recipe is a virtual memory file. ABC Batch uses virtual memory files for recipes to extend the effective size of console memory. When you save the recipe, the virtual memory file is converted to a standard disk file. Figure 1.10 shows how recipes are represented as virtual memory files.

![BATCH Master Recipe](image)

<table>
<thead>
<tr>
<th>Info</th>
<th>Save</th>
<th>Params</th>
<th>Valid</th>
<th>Edit</th>
<th>Print</th>
<th>Locals</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recipe Name</td>
<td>MRDEMO</td>
<td>Modification</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Comment</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Modification Time</td>
<td>08-Aug-96</td>
<td>14:54:52</td>
<td>Key Level</td>
<td>CONFIG</td>
<td>1</td>
<td></td>
</tr>
</tbody>
</table>

Tilde symbol indicates the recipe is a virtual memory file

**Figure 1.10. Identifying a Virtual Memory File**

If you leave the recipe without saving it, the recipe is saved as a virtual memory file designated by a tilde symbol in the ABC Data folder. You cannot run a Control Recipe saved as a virtual memory file. It must first be converted to a standard disk file. If you have system permission to change Control Recipes, see BA: 3-5 for instructions.

**NOTE:** If the console reboots while you are editing a recipe, you may lose some of your changes, because the virtual memory file is only partially saved on disk while the recipe is displayed.
Section 2: Running ABC Batch Recipes

This section describes how to set up and run ABC Batch recipes. Operator procedures typically include:

1. Calling up a Control Recipe
2. Entering parameter values for recipe operations.
3. Assigning Batch IDs to Control Recipes.
4. Validating Control Recipes and responding to warnings and errors.
5. Selecting batch unit sets.
6. Defining recipe locals.
7. Assigning local values to the recipe.
8. Making recipe printouts for recipe audit and analysis.

This section also includes useful commands for working with recipes. They include:

1. Scrolling the Working Recipe
2. Calling up a process graphic from the Working Recipe
3. Calling up an Operator Comment screen
4. Blocking and unblocking recipe icons
5. Suspending and restarting recipe execution
6. Locking and unlocking Unit Recipes
7. Creating a window label
8. Tracing links
9. Changing icon size
10. Calling up the Master Recipe
Starting the Control Recipe

The following procedures are used to prepare and then start execution of the Control Recipe. When you successfully start the Control Recipe, the Working Recipe automatically replaces the Control Recipe on the screen.

Calling Up the Control Recipe

Figure 2.1 shows the BATCH Control Recipe Config screen with the Menu Bar and a recipe. The Unit-Process icon in position 1 identifies the batch unit (in the example, UNIT_X is the batch unit).

☐ To call up the Batch Control Recipe:

- If you are creating a new Control Recipe from an existing Master Recipe, type:

  BACR (Master Recipe name) [ENTER]
  
or
  Save the Master Recipe and then press [EXCHANGE].

- If you are using an existing Control Recipe, type:

  BACR (Control Recipe name) [ENTER]
  
or
  Press [SELECT] on a Control Recipe saved in the ABC Data folder.

NOTE: If you omit the name of the Master Recipe or Control Recipe, the screen displays the last Control Recipe viewed.
Figure 2.1. Batch Control Recipe
## Entering Parameter Values

The Parameters Menu is used to enter or change the values of parameters in the parameter list. Parameters define values used by operations. The configuror creates a parameter list for each operation.

Parameter types and values include:

**Formula**
An optional formula for parameter values and types. The formula defines unique values for a specific product grade.

**Value Name**
The name of a formula value. The value and value type are automatically displayed for the parameter when you enter a formula.

**Value**
A parameter type for numeric values. Three fields are used to define “Value” parameters:

- **Low Lim**
The lowest allowable value that you can enter for a parameter.

- **Value**
The value of the parameter. The “Value” field must be within the low limit and high limit range.

  New parameters display “novalue” in the “Value” field to indicate that the parameter does not have a value. The “novalue” designation also appears if you attempt to enter a value that is outside the “Low” and “High” limit range.

- **High Lim**
The highest allowable value that you can enter for a parameter.

**String$**
A parameter type for character string values. String$ values are useful for report and log records.

**Time**
A parameter type for time values for year, month, day, hour, minute, and second; however, you do not have to enter all six values.

**Boolean$**
A parameter type for hex values. Hex values are useful for manipulating discrete control devices.
NOTE:

- On the Control Recipe, you can enter parameter values only in the “Value” field. You cannot enter or change limit values in the “Low Lim” and “High Lim” fields.

- If you attempt to enter a parameter value outside the limit range, the “Value” field rejects the entry and the following message is displayed:

  Entry Outside Limit

- On the Control Recipe, you can change formula values for a specific run of a Working Recipe but you cannot save them. If you leave the Control Recipe screen, parameters revert to the former values. To change formula values, enter alternative values in the “Value” field.

Calling Up the Parameters Menu

Figure 2.2 shows how to call up the Parameters Menu.

To call up the Parameters Menu:

1. Press [SELECT] on an O-Icon. The O-Icon is backlit in white.
2. Position the cursor on the “Params” field on the Menu Bar. The Parameters Menu appears. (If you do not first select the icon, the console beeps.)
Selecting Formulas

If the batch process uses formulas, you can assign a formula on the Parameters Menu in the “Formula” field. A formula is a set of parameter values assigned to a recipe that define a unique formula for a specific product grade.

The name of the formula is entered in the “Formula” field. To select formulas, the recipe must have a Formula Table assigned to it. To determine if a Formula Table has been assigned to the recipe, check the “Formulas Tbl” field in the Recipe Info window. To view the Recipe Info window, position the cursor on the “Recipe” field on the information menu.

Editing Parameters

The Parameters Menu displays the list of parameters for the operation. The first line in the Parameter list is the entry line, designated by the entry “>” symbol. To enter a value for a parameter in the list, you move the parameter to the entry line.

NOTE: Operators cannot enter parameters on the Working Recipe, unless the Working Recipe has been configured to allow operator entries. The Working Recipe must first be in Static mode.

Figure 2.3 shows how to use the Parameters Menu to edit parameters.
To move a parameter to the entry line:
- Enter the line number of the parameter in the entry line prompt (>), or
- Press [SELECT] on a parameter, or
- Use the trackball to scroll the parameter to the entry line.

To call up parameters for other O-Icons:
- Press [PAGE FORWARD] or [PAGE BACKWARD]. Icons appear in the order of their icon number; each is displayed with the associated parameter list.

To define parameters with formulas:
1. Move the parameter to the entry line. The entry line displays different fields for each type of parameter. Value names must be assigned to parameters in order to use formulas.
2. Enter a formula in the “Formula” field.

To define parameters without formulas:
1. Move the parameter to the entry line. The entry line displays different fields for each type of parameter.
2. Enter values directly in the “Value” field.

<table>
<thead>
<tr>
<th>Parameters</th>
<th>O-Icon 8</th>
</tr>
</thead>
<tbody>
<tr>
<td>VAR_1</td>
<td>Value</td>
</tr>
<tr>
<td></td>
<td>End target value for process completion &gt; 1</td>
</tr>
<tr>
<td>Low Lim</td>
<td>Value</td>
</tr>
<tr>
<td>30</td>
<td>&gt; 50</td>
</tr>
<tr>
<td>High Lim</td>
<td>Value</td>
</tr>
<tr>
<td>70</td>
<td></td>
</tr>
<tr>
<td>Eng Units</td>
<td>Value</td>
</tr>
<tr>
<td>Liters</td>
<td>Value</td>
</tr>
<tr>
<td>Val_1</td>
<td>Value</td>
</tr>
<tr>
<td>0. &lt;= .5 &lt;= 10 Liters</td>
<td></td>
</tr>
<tr>
<td>PRETEST$</td>
<td>String$</td>
</tr>
<tr>
<td>Process Stabilized</td>
<td></td>
</tr>
<tr>
<td>Flag$</td>
<td>Boolean</td>
</tr>
<tr>
<td>456B</td>
<td></td>
</tr>
<tr>
<td>Val_1</td>
<td>Value</td>
</tr>
<tr>
<td>RUN</td>
<td>Time</td>
</tr>
<tr>
<td>1992,10,20</td>
<td>4:30:15</td>
</tr>
<tr>
<td>Val_2</td>
<td>novalue</td>
</tr>
<tr>
<td>Close</td>
<td>Formula</td>
</tr>
<tr>
<td>&gt; Grade_1</td>
<td></td>
</tr>
</tbody>
</table>

**Figure 2.3. Editing Parameters**

### Assigning a Batch ID to the Control Recipe

A Batch ID is an alphanumeric code used by the system to identify the Control Recipe. The Control Recipe must have a Batch ID before you can start it.

You can enter a batch ID in one of two ways:
By entering it manually in the Validation/Start Menu. If you are required to enter a Batch ID manually, most likely your system administrator will tell you what code to use for the Batch ID.

By an automatic Batch ID procedure created and run by a configuror. If your system uses an automatic Batch ID procedure, you do not need to enter a Batch ID manually on the Validation/Start Menu.

**CAUTION**

If you are unsure of what method of Batch ID entry your system uses, ask your system administrator.

Figure 2.4 and Figure 2.5 show the steps to use to manually assign a Batch ID to a Control Recipe.

- **To call up the Validation/Start Menu:**
  - Position the cursor on the “Valid/Start” field on the Menu Bar. The Valid/Start Menu appears.

![Figure 2.4. Calling Up the Validation/Start Menu](image-url)
To assign a Batch ID to the Control Recipe:

1. Move the cursor to the “Batch Id” field. The cursor appears above the field.
2. Type the Batch identification code and press [ENTER]. The Batch identification appears in the “Batch Id” field.

<table>
<thead>
<tr>
<th>Batch Control Recipe Config 12-Aug-96 14:54:52</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Recipe Name</strong>: $$BACR**</td>
</tr>
<tr>
<td><strong>Modification</strong>: 0</td>
</tr>
<tr>
<td><strong>Comment</strong>:</td>
</tr>
<tr>
<td><strong>Modification Time</strong>: 12-Aug-96</td>
</tr>
<tr>
<td><strong>Task ID</strong>:</td>
</tr>
<tr>
<td><strong>Valid/Start Menu</strong></td>
</tr>
<tr>
<td><strong>Tag Mask</strong>: X X _ X X X X X _</td>
</tr>
<tr>
<td><strong>Batch Id</strong>: B2-6391</td>
</tr>
<tr>
<td><strong>Formula</strong>: Form_1</td>
</tr>
<tr>
<td><strong>Unit Set Index</strong>: 2</td>
</tr>
<tr>
<td><strong>Validation Status</strong>: Runnable</td>
</tr>
<tr>
<td><strong>Start Validate</strong>: Yes</td>
</tr>
<tr>
<td><strong>Check Params</strong>: Yes</td>
</tr>
<tr>
<td><strong>Close Error Log</strong>:</td>
</tr>
</tbody>
</table>

**Figure 2.5. Entering the Batch ID**
Validating and Starting the Control Recipe

Validation is a check to verify that the Control Recipe is configured correctly and uses current data. The Control Recipe must be validated successfully before it can start. You begin the validation process on the Valid/Start Menu. If warnings or errors are detected, you must acknowledge these conditions on the Error Log Menu.

Figure 2.6 and Figure 2.7 show how to begin the validation process.

To call up the Validation/Start Menu, if necessary:
- Position the cursor on the “Valid/Start” field on the Menu Bar. The Valid/Start Menu appears.

![BATCH Control Recipe Config](image)

### Selecting Batch Unit Sets

If the batch process uses batch unit sets, you can assign batch unit sets on the Validation/Start Menu in the “Unit Set Index” field. Batch unit sets are used to make multiple batch products from the same recipe. The unit set defines a set of units for a unique batch product.

The index number of the batch unit set is entered in the “Unit Set Index” field. The recipe must have a Unit Set File assigned to it in order for you to select batch unit sets. To determine if a Unit Set File has been assigned to the recipe, check the “Unit Set File” field in the Recipe Info window.
Beginning Validation

The “Start” and “Validate” fields start the validation process. If validation fails, the Error Log Menu appears with a list of errors or warnings.

You can check parameters as a validation option in the “Check Params” field:

**No**  
Do not check the parameter values during validation.

**Yes**  
Check for parameter values that are undefined. These parameter values are indicated by “novalue” in the “Value” field. If parameters without values are found during validation, the Parameters Menu appears. You must enter values for all parameters with “novalue” in order to complete validation successfully.

- **To validate the Control Recipe:**  
  - Move the cursor to the “Validate” field and press [SELECT]. If there are warnings or errors, the Error Log Menu appears.

- **Enable or disable validation:**  
  - Position the cursor on the “Yes” or “No” validation option to toggle the field.

- **To validate and start the Control Recipe:**  
  - Move the cursor to the “Start” field and press [SELECT]. If there are no warnings or errors, the “Start” field validates and runs the Control Recipe.

  - **Enable or disable parameter check:**  
    - Position the cursor on the “Yes” or “No” “Check Params” option to toggle the field.

---

**Figure 2.7. Validating and Starting the Control Recipe**
Responding to Validation Warnings and Errors

The Error Log Menu explains problems that are detected during validation. It appears automatically if validation fails.

Validation problems are indicated as either a “WARNING” or an “ERROR”. You must press [SELECT] on all warnings to acknowledge them (or the configuror must correct the causes of all errors) before you can run the Working Recipe. The system will not let you run the Working Recipe until you acknowledge all warnings or correct all errors. Once you have done this, the Error Log Menu displays a “Run” field.

If there are more warning messages than the Error Log Menu can display, validation stops. (The Error Log Menu can display a maximum of 10 messages). To continue validation, you must remove excess messages from the screen by pressing [SELECT] on each.

Figure 2.8 shows warnings and errors displayed on the Error Log Menu.
If the value of the “Check Parameters” field (on the Valid/Start Menu) is “Yes”, validation checks for parameters that do not have values. Validation halts and the Parameters Menu replaces the Error Log Menu on the screen. To continue validation, you must assign a value to each parameter with “novalue” in the “Value” field.

Parameters designated as “novalue” automatically scroll to the Parameters Menu edit line in succession as you enter values. After you enter values for all “novalue” parameters, select “Resume Validation” to continue validation.

For more information on parameters with “novalue” designations, see “Entering Parameter Values” on page 2-4.
Starting the Control Recipe from the Error Log Menu

You can validate and run the Control Recipe in a single step using the “Start” field on the Valid/Start Menu (see Figure 2.7). However, if the validation fails, you will have to correct errors or acknowledge alarms. If there are errors, you may have to correct them and validate the Control Recipe again.

If the validation has failed, you may be able to start the Control Recipe from the Error Log Menu. The following two conditions may be displayed:

- **Warning** - Icon validation (Unit or Operation) is set to “Warn”. By acknowledging the warning and selecting “Run”, you can start the recipe (see Figure 2.10).
- **Error** - Icon validation (Unit or Operation) set to “Halt”. The recipe cannot be started until the errors are corrected.

After you acknowledge the warnings and errors in the Error Log Menu, the Control Recipe displays a “Run” field. When you select the “Run” field, a Working Recipe is started. The Working Recipe is used to monitor and control execution of the batch process.

Figure 2.9 shows examples of two warnings that may appear in the Error Log Menu. The purpose of these warnings is to prevent unauthorized modifications of the Control Recipe or scripts. Each warning must be dealt with before you can run the Control Recipe without errors. For the first warning message, you must either update the script checksum in the appropriate table or replace the modified script with the original script that has the correct checksum from an archived tape or another disk. For the second warning message, either restore the correct table from a backup or open the Batch Master Recipe and update the “Reset Icon Mod Levels” in the “Info” menu in the “Config” window and create the Batch Control Recipe from the Batch Master Recipe.
Figure 2.9. Warnings Displayed in the Error Log Menu

Figure 2.10 shows how to start the Control Recipe from the Error Log Menu.

To run the Control Recipe:
- Press [SELECT] on the “RUN” field.

Figure 2.10. Starting the Control Recipe from the Error Log Menu
Printing Recipes

The Print Menu is used to print screen graphics or text information about the recipe configuration. Recipes that are too large to print on a single page are printed in numbered pages.

**NOTE:** You must first create an ASCII copy of the recipe before you can print text.

Figure 2.11 and Figure 2.12 show how to print the recipe.

- **To call up the Print Menu:**
  - Position the cursor on the “Print” field in the Menu Bar. The Print Menu appears.

- **To print recipe text:**
  1. If there is no ASCII copy of the recipe or the recipe has been modified, press [SELECT] on either the “Create ASCII” or “Overwrite ASCII” field.

- **To print a recipe graphic:**
  - Press [SELECT] on the “Graphic” field.

- **To overwrite the Control Recipe from an ASCII file:**
  - Press [SELECT] on the “Overwrite from ASCII” field.

---

**Figure 2.11. Calling Up the Print Menu**

**Figure 2.12. Printing the Control Recipe**
Defining Recipe Locals

Recipe “locals” define values for use by recipe icons. Unlike parameters that are used by specific icons, recipe locals are available to all icons on the recipe.

You can specify up to 10 values; each value has an identification number from 1 to 10.

Figure 2.13 shows the Recipe Locals Menu.

- To assign recipe locals:
  1. Position the cursor on the “Locals” field on the Menu Bar. The Recipe Locals Menu appears.
  2. Enter values and descriptions for recipe locals.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 &gt; 15.4</td>
<td>Volume A</td>
</tr>
<tr>
<td>2 &gt; 12</td>
<td>Volume B</td>
</tr>
<tr>
<td>3 &gt; 17.88</td>
<td>Volume C#</td>
</tr>
<tr>
<td>4 &gt;</td>
<td></td>
</tr>
<tr>
<td>5 &gt;</td>
<td></td>
</tr>
<tr>
<td>6 &gt;</td>
<td></td>
</tr>
<tr>
<td>7 &gt;</td>
<td></td>
</tr>
<tr>
<td>8 &gt;</td>
<td></td>
</tr>
<tr>
<td>9 &gt;</td>
<td></td>
</tr>
<tr>
<td>10 &gt;</td>
<td></td>
</tr>
</tbody>
</table>

Figure 2.13. Defining Recipe Locals
Useful Commands

The following commands are useful for working with recipes.

Scrolling the Working Recipe

The “Follow” command (Figure 2.14) on the Working Recipe Menu Bar scrolls the Working Recipe horizontally or vertically to show which icons are running. This command is useful if the flow chart is larger than what can be displayed on the console screen at any one time.

- To scroll the Working Recipe:
  - Press [SELECT] on the “Follow” command.

    ![Figure 2.14. Scrolling the Working Recipe with the “Follow” Field](image)

Calling Up a Process Graphic from the Working Recipe

The “Graphic” command (Figure 2.15) on the Working Recipe Menu Bar calls up a process graphic display. Process graphics are typically used to represent or control plant conditions during recipe execution.

- To call up a process graphic:
  - Press [SELECT] on the “Graphic” command.

    ![Figure 2.15. Calling Up a Process Graphic with the “Graphic” Field](image)
Calling Up an Operator Comment Screen

The “OpCom” command (Figure 2.16) on the Working Recipe Menu Bar calls up an Operator Comment screen. The operator can type in a comment (up to 80 characters in length) that is entered into the RS3 Operator Station (ROS) Journal. **This menu item is useful only when ABC Batch Messaging is enabled.** See the *ROS Getting Started Manual* for more information.

- **To call up the Operator Comment screen:**
  - Position the cursor on the “OpCom” field on the Menu Bar. The Comment screen appears.
  - After entering the desired comment, position the cursor in the “Log” field and press [SELECT].

![Figure 2.16. Calling Up an Operator Comment Screen](image)

### Blocking and Unblocking Recipe Icons

You can block execution of operations that have not executed. A red arrow indicates at what point the recipe is blocked. All subsequent icons after the red arrow are blocked from execution. If the recipe branches before the red arrow, the block only prevents the icons in line with the blocked icon from executing.

You can block and unblock the Working Recipes either from the Edit Menu or from the Icon View Menu. Figure 2.17 shows how to block and unblock a Working Recipe from the Icon View Window.
To block or unblock a step:
1. Position the cursor on the “View” field on the Menu Bar. The View Menu appears.
2. Position the cursor on the “Icon View” field. The Icon View window appears.
3. Position the cursor on the “Block field. The Block Menu appears.

Block Menu:
4. In the “Icon” field, enter the number of the icon you want to block.
5. Press [SELECT] on the “Accept” field to block the specified operation icon. A red arrow appears on the screen pointing to the link leading to the specified icon.

Unblock Menu:
6. In the Icon View window, position the cursor on the “Unblock” field. The Unblock Menu appears.
7. In the “Icon” field, enter the number of the icon that you want to unblock.
8. Press [SELECT] on the “Accept” field to unblock the specified operation icon. The red arrow pointing to the link leading to the icon disappears and the recipe can continue.

Figure 2.17. Blocking and Unblocking a Recipe
Suspending andRestarting Recipe Execution

The Static command suspends execution of the Working Recipe. The Working Recipe suspends execution after completing the currently executing icon. The recipe displays a red arrow pointing to any links that have not been executed.

The Restart and QRestart commands restart execution of a Working Recipe suspended by a Static command. The Restart command validates the recipe for any changes made to it while it was suspended. The QRestart command restarts execution without validating for changes.

You can suspend and restart the Working Recipe from the Recipe View Window. Figure 2.18 shows how to suspend and restart a Working Recipe.

**NOTE:** To suspend execution of the Unit Recipe, execute the Static command on the UR View window instead.
To suspend a recipe:
1. Position the cursor on the “View” field on the Menu Bar. The View Menu appears.
2. Position the cursor on the “Recipe” field on the View Menu. The Recipe View window appears.
3. Press [SELECT] on the Static field. The “Mode” field changes from Normal to Static and the recipe suspends execution.

To restart a recipe:
1. Press [SELECT] on the “QRestart” or “Restart” field. The “Mode” field changes from Static to Normal and the recipe resumes execution.

Figure 2.18. Suspending and Restarting a Recipe
Locking and Unlocking Unit Recipes

You can prevent a Unit Recipe from executing by locking it (see Figure 2.19). The rest of the Working Recipe will continue to execute without the use of the Unit Recipe. Unlock the Unit Recipe to remove the lock (see Figure 2.20).

Locking a Unit Recipe prevents it from starting. Therefore, the Unit Recipe must be idle in order to lock it. When the Unit Recipe is locked, a block is also automatically added to the Main Recipe, preventing the Main Recipe from proceeding past the Unit Recipe’s Start-UR icon. Once the Unit Recipe is unlocked, the user must also unblock the Start-UR icon.

To lock a Unit Recipe:

NOTE: In order to “lock” a Unit Recipe, it must not be started yet.

1. Position the cursor on the “View” field on the Menu Bar. The View Menu appears.
2. Position the cursor on the “Unit Recipe” field on the View Menu. The UR View window appears.
3. Press [SELECT] on an icon on the Unit Recipe to select it.
4. Press [SELECT] on the “Lock” field to lock the Unit Recipe.

Figure 2.19. Locking a Unit Recipe

To unlock a Unit Recipe:

2. The Main Recipe will be blocked (Halt indication is displayed). Press the icon just below the “Halt” indication and then select View/Icon View and “unblock”.

Figure 2.20. Unlocking a Unit Recipe
Creating a Window Label

A window label is useful if you want to call up a submenu directly without using the Menu Bar, or if you want to prevent a menu from covering the screen. You can use the window label to change back and forth quickly between the menu and screen to check recipe icons that are hidden by the menu. You can create a window label for most recipe menus. You press [SELECT] on a window selection to create a window label at the top right corner of the recipe screen.

**NOTE:** You cannot create a window label for the Error Log Menu.

Figure 2.21 shows how to create a window label field.

---

**To create a window label field:**
- Call up a menu and press [SELECT] on the menu selection. A window label appears as a field at the top right corner of the recipe.

**To use the window label:**
- Position the cursor on the window label to call up the window directly.
Tracing Links

On complicated flow charts, links between paths may be difficult to trace. Turning links on or off can visually assist you in tracing links. When a link is turned on, the link and icon it connects to are colored white on the screen.

To turn links on or off, you select an icon on the recipe and specify whether you want to turn on the link before the icon, after the icon, or both before and after the icon. A single field on the Edit Menu can toggle between the following field values: “No Links”, “Next”, “Prev”, and “Both”. The default field value is “No Links”.

**NOTE:** The procedure for tracing links is the same on both the Control Recipe and the Working Recipe.

Figure 2.22 shows how to call up the Edit Menu. Figure 2.23 shows how to turn on links.

- **To call up the Edit Menu:**
  - Position the cursor on the “Edit” field on the Menu Bar. The Edit Menu with trace fields appears.

![Figure 2.22. Calling Up the Edit Menu](image)
To turn the previous link on:
1. Press [SELECT] on a recipe icon (for example, ADD-RAW-2).
2. Press [SELECT] on the “No Links” field to toggle the field value to “Prev”. The link before the icon turns white.

To turn both links on:
1. Press [SELECT] on a recipe icon (for example, ADD-RAW-2).
2. Press [SELECT] on the “No Links” field to toggle the field value to “Both”. The links before and after the icon turn white.

To turn the next link on:
1. Press [SELECT] on a recipe icon (for example, ADD-RAW-2).
2. Press [SELECT] on the “No Links” field to toggle the field value to “Next”. The next link after the icon turns white.

Figure 2.23. Turning On the Previous, Both, or Next Links
Changing Icon Size

The Size Icon window changes the size of icons and text on the Master Recipe. You enter the size you want as a percentage from 1 to 100%.

To change icon size:
1. Position the cursor on the “Edit” field to call up the Edit Menu.
2. Position the cursor on the “Size Icon” field on the Edit Menu. The Size Icon window appears.
3. In the “Percent” field, enter a number for the size scale for recipe icons. When you close the window, the icons change size.

Figure 2.24. Changing Icon Size
Calling Up the Master Recipe

The operators key allows you to make printouts of the Master Recipe. Figure 2.25 shows the BATCH Master Recipe Config screen with the Menu Bar and default icons. The Batch Master Recipe is used to configure a batch process.

- **To call up the Batch Master Recipe:**
  - Type the following command at the command line:
    
    \[ \text{BAMR (name)} \text{ [ENTER]} \]
    
  - or
  
  Press [SELECT] on a Master Recipe saved in the ABC Batch file folder.

---

**Figure 2.25. Batch Master Recipe**

<table>
<thead>
<tr>
<th>Info</th>
<th>Save</th>
<th>Params</th>
<th>Valid</th>
<th>Edit</th>
<th>Print</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recipe Name</td>
<td>$$BACR</td>
<td>Modification 0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Comment</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Modification Time</td>
<td>12-Aug-96</td>
<td>14:54:52</td>
<td>Key Level</td>
<td>CONFIG 1</td>
<td></td>
</tr>
<tr>
<td>Task ID:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1

2
Section 3: Using Batch Process Graphics

RS3 includes several process graphic features for use exclusively with ABC Batch. These include:

- BAINPUTW (Batch Input Window) graphic object
- BARCPW (Recipe Viewing Window) graphic object
- BFACE (Batch Faceplate) graphic object
- RECIPE (Recipe Faceplate) graphic object

The ABC Batch graphic objects are window interfaces that let you monitor and control execution of tasks and Working Recipes from the process graphic.
Batch Input Window: BAINPUTW Object

The BAINPUTW object displays messages and input prompts on the process graphic. Figure 3.1 shows the BAINPUTW object.

Figure 3.1. BAINPUTW Graphic Object
Recipe Viewing Window: BARCPW Object

The BARCPW object displays a window version of the Batch Working Recipe screen for monitoring the execution of the Working Recipe. It uses color coding (green, yellow, or blue) to show the execution state (finished, executing, or not started) of recipe steps. The color coding is configurable by the user.

The node address and status of the currently executing operation appear at the top of the window. The trackball lets you scroll the recipe (up or down, left or right) inside the window by pressing [SELECT] on the scrolling arrows.

Figure 3.2 shows the BARCPW object.
The BFACE object is used to monitor and control batch tasks from a graphic display. You can select predefined field items on the batch faceplate.

For a description of items on the BFACE object, see BA: 6-1.

Figure 3.3 shows the BFACE object.

Figure 3.3. BFACE Graphic Object
Recipe Faceplate: RECIPE Object

The RECIPE object provides status information on Working Recipe units and operations. Figure 3.4 shows the RECIPE object.

<table>
<thead>
<tr>
<th>Unit Name</th>
<th>UNIT_X</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control Recipe Name</td>
<td>CR_PROD</td>
</tr>
<tr>
<td>Batch ID</td>
<td>B2-7393</td>
</tr>
<tr>
<td>Start Time</td>
<td>14:54:52</td>
</tr>
<tr>
<td>Unit Name</td>
<td>UNIT_X</td>
</tr>
</tbody>
</table>

- **Status**: ACTIVE
- **Operation Name**: ADD_R_1

- **Status**: ACTIVE
- **Operation Name**: ADD_R_2

- **Status**: ACTIVE
- **Operation Name**: ADD_R_3

- **Status**: ACTIVE

- **More**

**Figure 3.4. RECIPE Object**

- **To call up the Working Recipe or a related graphic display:**
  - Press [SELECT] on the Batch ID.

- **To display additional parallel operations:**
BARCPW graphic object, 3-3
Batch faceplate, 3-4
Batch ID assignment, 2-7–2-8
Batch ID procedure, automatic, 2-8
batch process graphics, 3-1–3-5
batch recipes, 1-2–1-13
batch unit sets, 1-3, 1-7, 2-10
BFACE graphic object, 3-4
blocking recipes, 2-19

components, recipe, 1-5–1-12
Control Recipes, 1-2, 1-8, 2-2–2-17
assigning a Batch ID, 2-7–2-8
calling up, 2-2
Error Log Menu, 2-14
parameter values, 2-4–2-7
printing, 2-16
recipe locals, 2-17
starting, 2-10–2-13
validating, 2-10–2-13

labels, decision, 1-12
links
icon, 1-10
path, 2-25

Main Recipe, 1-2
main recipe, 1-6, 1-7, 1-9
Master Recipe, 1-2
menu bar, 1-5
menu fields, 1-6
O

OpCOM command, 2-19
operator comment, 2-19
operator key, 1-1
operator privileges, 1-1

P

parallel batch units, 1-7
parallel operations, 1-10
parameter values, Control Recipe, 2-4–2-7
Parameters Menu, Control Recipe, 2-5
parameters without values, 2-13
parameters, Control Recipe, 2-6–2-7
Print Menu, 2-16
process graphic, 2-18

Q

QRestart command, 2-21

R

recipe, batch, 1-2
recipe components, 1-5–1-12
recipe faceplate, 3-5
recipe locals, 2-17
RECIPE object, 3-5
recipe viewing, 3-3
recipes
  batch, 1-8
  blocking and unblocking, 2-19
control, 1-2, 1-8, 2-7–2-16
main, 1-2, 1-6, 1-7, 1-9
master, 1-2, 2-28
suspending and restarting, 2-21
unit, 1-2, 1-6, 1-7, 1-9, 2-23
working, 1-2
Restart command, 2-21
restarting recipes, 2-21

S

Static command, 2-21
suspending recipes, 2-21
system access, 1-1

U

Unit Recipes, 1-2, 1-6, 1-7, 1-9
  locking and unlocking, 2-23
  unblocking recipes, 2-19

V

validation warnings and errors, 2-12
Validation/Start Menu, 2-10–2-13
Validation/Start menu, 2-8
virtual memory files, 1-13

W

window labels, 2-24
Working Recipes, 1-2, 2-18